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1 Document Conventions 
To highlight the most important points, the following terms are used to draw attention to key 
information and settings. 

Key: 

Configuration Indicates a recommended setting or configuration parameter to set. 

Information Highlights important facts and information to help the installer better 
understand the installation and make better use of the installed components. 

Caution Highlights areas where potential problems can arise, or misconfigurations 
occur, to help the installer avoid errors or loss of data. 

 

This document uses the following typographic conventions: 

Brackets indicate a clickable screen button or field. 

Example: [Button]  
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2 About this Document 
This document provides instructions on how to manually install and configure the various open 
source products and tools as part the eventual installation of the Model Tribal System (MTS).  

This document is intended to explain how to: 

• Create the standard development environment for the MTS application, with the latest Office 
of Child Support Enforcement approved technologies 

• Understand and interact with the install programs 

• Complete a basic pre-configuration install of the MTS 
 

Information  This document does not cover the customized application configuration or use of an 
installed MTS application.  To learn how to configure or us the MTS, refer to other 
documentation. 

 

Caution This document may be updated to reflect changes in one or more of the open source products 
used in the installation and configuration process.  The latest version can always be found in 
Alfresco. 
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3 Process Overview 
The process consists of three major areas.  Each process must be completed in order and 
completely before the next process can begin.  The major process areas consist of the following 
high-level steps below: 

 

3.1 Software Overview 
In this section we will discuss system requirements, and software requirements.  The installation 
files can be obtained from the internet, one tool requires licensing and another simple 
registration.  It is expected that the user is knowledgeable in how to obtain basic tools from the 
Internet. 
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3.2 Installation of Development Tools 
The installation & deployment process is comprised of the sub-processes listed below.  Each 
sub-process is described in detail with steps for completing the tasks and screen shots. 

 

Caution The reader must follow the subsections in the order presented within this guide.  Each sub-
process must be completed in its entirety before commencing to the next sub-process in the 
sequence. 

 
3.3 Application Configuration 
This process consists of application configuration, and database installation/update. 

 

3.4 Prepare, Deploy, and Launch the Application 
This section will give instructions on final database setup with structure/data and actually launch 
the Application. 

 

Information  A complete install and deployment can be expected to be performed in four hours, 
pending any unforeseen issues.  
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4 Software Overview 
The application consists of a tightly coupled set of tools, all built on/with Java. 

Before you start installing any of the tools below, make sure you have the correct version of Java 
SDK installed on your machine. 

 

4.1 Operating System and Java Requirements 
 

Operating 
System 

Version Java Version Link 

MAC OS 
X 

10.7 or 
later 

Java for OS X 
2013-003 (Java 
1.6.0_45) 

http://support.apple.com/kb/DL1572 

Windows 7 or 
later 

Java 1.6.0_65 http://www.oracle.com/technetwork/java/javase/d
ownloads/jdk6downloads-1902814.html 

 

To test what version of java you have installed: 

Open a terminal/command window and type: java –version 

If you show earlier than java 1.6.0_65, then you should install a later version of 1.6. 

 

Caution Do NOT install Java 1.7 SDK.  The Adobe Flex Builder does not support Java 1.7. 

 
4.2 Software Requirements 
 

4.2.1 Platform Independent 

Application Version Filename Link 

Jboss 5.1 jboss-5.1.0.GA-jdk6.zip http://sourceforge.net/pro
jects/jboss/files/JBoss/JB
oss-5.1.0.GA/ 

 

 

http://support.apple.com/kb/DL1572
http://www.oracle.com/technetwork/java/javase/downloads/jdk6downloads-1902814.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk6downloads-1902814.html
http://sourceforge.net/projects/jboss/files/JBoss/JBoss-5.1.0.GA/
http://sourceforge.net/projects/jboss/files/JBoss/JBoss-5.1.0.GA/
http://sourceforge.net/projects/jboss/files/JBoss/JBoss-5.1.0.GA/
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4.2.2 Mac OS X Platform 

Application Version Filename Link 

Eclipse IDE Juno / 4.2 eclipse-jee-juno-SR2-macosx-
cocoa-x86_64.tar.gz 

http://www.eclipse.org/download
s/ 

Flash Player 
Plugin 
content 
debugger 

11 or above flashplayer_11_plugin_debug.dmg http://www.adobe.com/support/fl
ashplayer/downloads.html 

MacPorts 2.1.3 MacPorts-2.1.3-10.8-
MountainLion.pkg 

http://www.macports.org/install.p
hp 

Xcode 4.6.2 or 
above 

 AppStore 

MySQL 5.1 mysql-5.1.56-osx10.6-
x86_64.dmg 

http://dev.mysql.com/downloads/
mysql/5.1.html 

Adobe Flash 
Builder 

4.7 FlashBuilder_4_7_LS10.dmg http://www.adobe.com/products/f
lash-builder-standard.html 

This product requires a license 
key. 

MySQL 
Workbench 

5.2 mysql-workbench-gpl-5.2.47-osx-
i686.dmg 

http://dev.mysql.com/downloads/
tools/workbench/ 

 

4.2.3 Windows 7 Platform 

Application Version Filename Link 

Eclipse IDE Juno / 4.2 eclipse-jee-juno-SR2-win32-
x86_64.zip 

http://www.eclipse.org/download
s/ 

Adobe Flash 
Player 
debugger 

11 or above This varies based on your 
Windows Version (7 vs 8) 
memory bit size (64 vs 32) and for 
Windows 7  IE vs. Netscape 
compatible browser  

http://www.adobe.com/support/fl
ashplayer/downloads.html 

http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/
http://www.adobe.com/support/flashplayer/downloads.html
http://www.adobe.com/support/flashplayer/downloads.html
http://www.macports.org/install.php
http://www.macports.org/install.php
http://dev.mysql.com/downloads/mysql/5.1.html
http://dev.mysql.com/downloads/mysql/5.1.html
http://www.adobe.com/products/flash-builder-standard.html
http://www.adobe.com/products/flash-builder-standard.html
http://dev.mysql.com/downloads/tools/workbench/
http://dev.mysql.com/downloads/tools/workbench/
http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/
http://www.adobe.com/support/flashplayer/downloads.html
http://www.adobe.com/support/flashplayer/downloads.html
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Application Version Filename Link 

SlikSVN 1.7.9 Slik-Subversion-1.7.9-x64.msi http://www.sliksvn.com/en/down
load 

MySQL 
Installer 

5.6 mysql-installer-community-
5.6.11.0.msi 

http://dev.mysql.com/downloads
/ 

Adobe Flash 
Builder 

4.7 AdobeApplicationManager.exe http://www.adobe.com/products/
flash-builder-standard.html 

This product requires a license 
key. 

 
 

http://www.sliksvn.com/en/download
http://www.sliksvn.com/en/download
http://dev.mysql.com/downloads/
http://dev.mysql.com/downloads/
http://www.adobe.com/products/flash-builder-standard.html
http://www.adobe.com/products/flash-builder-standard.html
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5 Installation of Development Tools 
It is assumed that the reader knows how to install Java; therefore Java installation is not included 
in these instructions.   

 

5.1 Install Flash Debugger 
There is nothing special about installing the debug version.  Follow standards instructions for 
installing any browser plugin. 

To test that the debug version is installed: 

• Go to http://helpx.adobe.com/flash-player/kb/find-version-flash-player.html 

• Then in the box that says “Flash player is running on your screen”, right click to see if a 
menu option comes up that states [Debugger].  See Figure 1 

 

 
Figure 1 

 

5.2 Install Subversion 
Subversion is required to support the retrieval of software.  In MAC OS the subversion plugin 
for Eclipse does not include the native libraries, so they absolutely must be installed.  For both 
platforms, the subversion client will be required in the development environment if we wish to 
use Maven. 

 

http://helpx.adobe.com/flash-player/kb/find-version-flash-player.html
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5.2.1 Windows Installation 

Procedure: 
Simply install the SlikSvn application.    

Caution Make sure you select COMPLETE installation. 

5.2.2 MAC OS X Installation 

Procedure: 
The only consistent mechanism for installing the subversion native libraries is to build them.  
CollabNet for MAC OS is supported by community developers, so may or may not work for the 
OS version that you have. 

First you need to install Xcode from App Store. 

Once that is completed, start the Xcode application.  Go to [Xcode]->[Preferences]-
>[Downloads] and install component named "Command Line Tools".  After that, all the relevant 
tools will be placed in /usr/bin folder and you will be able to use them. 

For later version of Xcode (5+) once you have launched Xcode at least once, then open 
command line and type:  xcode-select --install 
Now install MacPorts application package.  

 

Caution MacPorts is Version specific to the OS. 

If you are running MAC OS 10.7  use MacPorts-2.1.3-10.7-Lion.pkg 

If you are running MAC OS 10.8 use  MacPorts-2.1.3-10.8-MountainLion.pkg 

 

Information  In MAC OS, when installing an application from other than the AppStore, you will have 
to change your security parameters in setup to allow you to install an application that is 
not identified.  

 

Once you have installed MacPorts then: 

Make sure that MacPorts is up to date.  Open a new terminal and type: 

sudo port selfupdate 
You will be asked for your password. 

Ports will now check to see if it’s up-to-date.  It may look something like this: 

http://itunes.apple.com/us/app/xcode/id448457090?mt=12
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Mikes-MacBook-Pro:~ mgoshorn$ sudo port selfupdate 

Password: 

--->  Updating Mac Ports base sources using rsync 

MacPorts base version 2.1.3 installed, 

MacPorts base version 2.1.3 downloaded. 

--->  Updating the ports tree 

--->  MacPorts base is already the latest version 

The ports tree has been updated. To upgrade your installed ports, you should run 

  port upgrade outdated 

Mikes-MacBook-Pro:~ mgoshorn$ 

 
 

Information Later when doing upgrades to the installed version of subversion, you can following the 
instructions listed above:  sudo port upgrade outdated 

This will update subversion to the latest version. 

 

In the terminal type the following command: 

sudo port install subversion-javahlbindings +no_bdb +universal 
This will take quite some time. (20+ minutes depending on network and machine speeds) 

The final 4 steps of the process will look like this:  

 

--->  Cleaning subversion-javahlbindings 

--->  Updating database of binaries: 100.0% 

--->  Scanning binaries for linking errors: 100.0% 

--->  No broken files found. 
Mikes-MacBook-Pro:~ mgoshorn$ 

 

Then the job will finish and return to the command prompt. 

 

Information  You may wish to read the post at the below link to understand more about 
JavaHL:  http://subclipse.tigris.org/wiki/JavaHL#head-
5bf26515097c3231c1b04dfdb22c036bc511926b 

 

http://subclipse.tigris.org/wiki/JavaHL#head-5bf26515097c3231c1b04dfdb22c036bc511926b
http://subclipse.tigris.org/wiki/JavaHL#head-5bf26515097c3231c1b04dfdb22c036bc511926b
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5.3 Test SVN installation. 
Test that the command line SVN tools are working and what version you have: 

Procedure: 
In a terminal/command window type:  svn –h 

You should get a usage response, telling you all the command line options. 

 

Mikes-MacBook-Pro:~ mgoshorn$ svn -h 
usage: svn <subcommand> [options] [args] 

Subversion command-line client, version 1.7.10. 

Type 'svn help <subcommand>' for help on a specific subcommand. 

Type 'svn --version' to see the program version and RA modules 

  or 'svn --version --quiet' to see just the version number. 

Etc… 

 

You need to make sure you have version 1.7.1 or later. 

 

5.4 Create Eclipse Workspaces 

Information MTS supports three environments in Subversion.  Production is in the trunk, test and 
devl code base in under the branches.  

 
Procedure: 
Create a new folder off the root directory of your computer named  

EclipseWorkbench 

Create a folder called Workspaces under EclipseWorkbench folder.  

Drill-down into the Workspaces folder and create three additional folders as follows: 

• devl 
• test 
• prod 

When done you should have the following:  Figure 2 
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Figure 2 

 

5.5 Eclipse Installation 
Unzip the Eclipse into the EclipseWorkbench Folder and rename the folder “eclipse” to 
Eclipse64. 
 

5.6 JBoss Application Server Installation 
Unzip and copy the JBoss zip file under the EclipseWorkbench folder.  See Figure 3 
 

 
Figure 3 

 

5.7 Temporarily Disable Any Virus Protection Software 
Virus protection software could inhibit or block the downloading of updates during the next 
steps.  When this process is complete, you should re-activate your virus protection software. 

 

5.8 Adobe Flash Builder Installation 
This process will vary by MAC OS or Windows environments. 

 

5.8.1 MAC OS X Installation 

Procedure: 
Create a folder named AdobeFlexBuilder under the EclipseWorkbench folder. 
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Proceed with the install of Flash Builder.  See Figure 4  

 
Figure 4 

 

Double click on [Adobe Flash Builder] icon at the top. 

Double click the Install.app.  See Figure 5 
 

 
Figure 5 

 

Application will initialize.  See Figure 6 
 

 
Figure 6 
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Then select “Install”.  See Figure 7 
 

 
Figure 7  

 

Accept the license Agreement. 

On the next page enter a license key.  Click [Next].   

If you have an upgrade license key, you will be required to enter the license key of the original 
version.  See Figure 8 
 

 
Figure 8 
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Once this is done, Adobe will require you to login.  See Figure 9 
 

 
Figure 9 

 

Finally when this is complete you will be shown the options screen. 

You can select both Options, but only [Adobe Flash Builder 4.7] is required.  See Figure 10 
 

 
Figure 10 
 

Notice the “Location:” section at the bottom.  Make sure to enter 
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/EclipseWorkbench/AdobeFlexBuilder  
Then click [Install]. 

The application will proceed to install.  See Figure 11 
 

 
Figure 10 

 

5.8.2 Windows Installation 

Procedure: 
Run the AdobeApplicationManager.exe. 
Initialization might take some time (2+ minutes) so be patient.  See Figure 12. 

 
Figure 11 

 

Sign in: See Figure 13 

 
Figure 12 
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Accept the licensing agreement.  See Figure 14. 
 

 
Figure 13 

 

Now find the Flex Builder Application.  See Figure 15. 
 

 
Figure 14 

 

Then click [Install]. 
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You will be asked if you want a trial of official version.  See Figure 16. 
 

 
Figure 15 

 

Enter the Serial Number on the next page, and then follow the instructions.  The default 
installation will go to C:\Program Files\Adobe\Adobe Flash Builder 4.7 (64 Bit). 

 

5.9 Install Adobe Flash Builder Plugin 
After successful installation of Adobe Flash Builder, installation of the Adobe Flash Builder 
Eclipse Plug-in is required. 

Procedure: 
Find the AdobeFlexBuilder directory: 

 MAC OS:  /EclipseWorkbench/AdobeFlexBuilder/Adobe Flash Builder 4.7  
 Windows:  C:\Program Files\Adobe\Adobe Flash Builder 4.7 (64 Bit) 

There you will find a utilities directory. 

Double click on the “Adobe Flash Builder 4.7 Plug-in Utility (.app in MAC OS [Figure 17],  
.exe in Windows [Figure 18]). 
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Figure 16 

 

 
Figure 17 

 

Flash Builder supports installation as a plugin to an existing Eclipse instance.  Follow the steps 
below: 

Select the language and click [OK]. 

Select the Flash Builder installation location: 

MAC OS:  /EclipseWorkbench/AdobeFlexBuilder/Adobe Flash Builder 4.7 
Windows:  C:\Program Files\Adobe\Adobe Flash Builder 4.7 (64 Bit) 

Select the eclipse folder into which you want Flash Builder to be plugged into 
(/EclipseWorkbench/Eclipse64) and click [Next]. 

Review the pre-installation summary and click on [Install]. 

On a MAC, you might get the following popup as shown in Figure 19. 
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Figure 18 

 

If you do get the popup, just click [Yes to All].  If you didn’t, then don’t worry about it. 

And you should finally be presented with this screen.  See Figure 20. 
 

 
Figure 19 

 

5.10 Modify eclipse.ini File 
Following installation, it is recommended that you edit the eclipse.ini file for your Eclipse 
instance, so that it includes the following settings under:  

“–vmargs”: 
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-Xms512m 
-Xmx2048m 
-XX:MaxPermSize=256m 
-XX:PermSize=64m  
-XX:+UseParallelGC 

See below for example edited file. 

 

5.10.1 MAC OS Installation 

Procedure: 
Find the Eclipse.app line.  Right click on it and click on [Show Package Contents].  See Figure 
21. 
 

 
Figure 20 

 

Then find eclipse.ini   (See Figure 22) 
 

 
Figure 21 

 

5.10.2 Windows Installation 

Procedure: 
Using Windows Explorer find: 



Eclipse Developer’s Manual 

Version 1.21 06/04/2014 27 
 

C:\EclipseWorkbench\Eclipse64\ 
Find eclipse.ini listed in that directory. 

 

5.10.3 Modify the eclipse.ini file. 

Procedure: 
Edit it with text editor. Modify or add the arguments shown in 5.10 above.  See Figure 23. 

 

Caution Be very careful to choose a text editor that does not add “invisible” characters to the file.  For 
example MSWord would NOT work.  It’s best to modify the file with either vi (MAC) or the 
notepad command (Windows), from a terminal/command window.  Introduction of invisible 
characters or other improper formatting could cause the application fail to start. 

 

 
Figure 22 

 

5.11 Launch Eclipse  
Procedure 
Launch Eclipse from the Eclipse64 folder.   

MAC OS:  Eclipse.app 
Windows: eclipse.exe 
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Figure 23 

 

When eclipse launches, a “Workspace Launcher” dialog box will appear (see Figure 24).  Click 
[Browse…] and navigate to the EclipseWorkbench/Workspaces directory.  Select the [devl] 
workspace under workspaces directory.  See Figure 25. 
 

 
Figure 24 
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After selection the Dialog should look like Figure 26. 
 

 
Figure 25 

 

Click [OK] 

Close the welcome screen by clicking on the [Workbench].  See Figure 27. 
 

 
Figure 26 
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5.11.1 Install Subclipse Plugin for Eclipse 

There was once great debate about which Subversion tool to plugin to Eclipse:  Subclipse or 
CollabNet.  CollabNet has a more robust “merge” tool.  

This debate is now moot. 

As part of the development of the merge tracking feature in Subversion 1.5, CollabNet, the 
corporate sponsors of the Subversion project, developed a powerful graphical merge client 
feature on top of Subclipse.  This has been available since the release of Subversion 1.5 as part of 
the CollabNet Desktop - Eclipse Edition, an open-source and EPL licensed desktop for accessing 
CollabNet TeamForge from Eclipse. 

CollabNet has now made this merge client available to Subclipse users as part of the installation 
of Subclipse 1.6.x from the Subclipse update site.  Users who want the full functionality of the 
CollabNet Desktop can still install the desktop, but those just looking for an excellent Subversion 
merge client now have an easier way to install this client into Eclipse.  

 

Information  On the MAC, you must have the SVN client installed, and the version installed must 
match the subclipse version.  At the time of this publication that was 1.7.x.  You can find 
your SVN version by going to the terminal and typing:  svn –version  

Visit http://subclipse.tigris.org/wiki/JavaHL to see the required SVN version mapping. 

 

Procedure 
Click on Menu Bar:  [Help] -> [Eclipse Market Place …].  See Figure 28. 
 

 
Figure 27 

http://www.open.collab.net/
http://desktop-eclipse.open.collab.net/servlets/ProjectProcess?pageID=MEuUjb
http://desktop-eclipse.open.collab.net/
http://www.open.collab.net/products/sfee/
http://subclipse.tigris.org/wiki/JavaHL
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In the marketplace, search for “subclipse”.  See Figure 29 
 

 
Figure 28 

 

Then click [Install] and follow the instructions. 

You will get this Security Warning.  See Figure 30. 
 

 
Figure 29 

 

Click [OK] 

At the end, the process will ask to restart Eclipse.  See Figure 31. 
 

 
Figure 30 

 

Click [Yes].   

When it re-starts up reselect the workspace, and click [Workspace]. 

Then you will get the following:  See Figure 32 
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Figure 31 

 

You can choose to report usage to the Subclipse team, but I recommend against it. 

Make your choice, and then click [OK]. 

 

5.11.2 Install JBoss tools Plugin for Eclipse 

Procedure 
Click on the Menu Bar:  [Help] -> [Eclipse Market Place …]. 

In the Marketplace, search for JBoss tools.     

Look for the correct version (Juno).  See Figure 33. 
 

 
Figure 32 
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Then click [Install] and follow the instructions.  Again, you will be warned about security.  See 
Figure 34. 
 

 
Figure 33 

 

Click [OK] 

It will ask to restart Eclipse.  Click [Yes].  When it starts up reselect the workspace, and click 
[Workspace]. 

Then you will be asked if you want to participate in JBoss usage reporting.  See Figure 35. 
 

 
Figure 34 

 

I recommend that you click [NO]. 

 

5.11.3 Install Jaspersoft Studios 

Procedure 
Click on the Menu Bar:  [Help] -> [Eclipse Market Place …]. 
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In the Marketplace, search for Jaspersoft.  See Figure 36. 
 

 
Figure 35 

 

Then click [Install] and follow the instructions. 

Again, you will be warned about security.  See Figure 37. 
 

 
Figure 36 

 

Click [OK] 

Again it will ask to restart Eclipse.  [Yes] 

After you click on the workbench, you will NOT be presented with a usage popup this time. 

 

5.11.4 Make Eclipse Check for Updates and Install 

Procedure 
Click on the Menu Bar:  [Help] -> [Check for Updates] 

If the system finds any software to update, update everything in the list, accept any license 
agreements, and close and restart eclipse once everything is installed. 
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5.11.5 Turn off Automatic Builds 

Procedure: 
Click on Project from the Eclipse Menu Bar (see above).  Click on the “Build Automatically” 
option to turn it off.   See Figure 38. 
 

 
Figure 37 

 

5.11.6 Verify Java SDK 

Procedure: 
Navigate to the Preferences pop-up: 

MAC OS:  [Eclipse] -> [Preferences]. 

Windows:  [Windows] -> [Preferences]. 

Expand Java and then click on [Installed JREs] from the list. 

Make sure that the correct Java SDK was installed:  See Figure 39.  
 

 
Figure 38 
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Expand [Installed JREs]. 

Select [Execution Environments], and then select JavaSE-1.6.  See Figure 40. 
 

 
Figure 39 

 

MAC OS:  Select [JVM Contents (MacOS X Default)] as the default JRE  

Windows: Select [jre6] as the default JRE 

Click [OK] to save the setting.  

 

5.11.7 JBoss Application Server Configuration in Eclipse  

Procedure: 
Click on the Java EE Perspective tab.  See Figure 41. 
 

 
Figure 40 

 

If the tab is not showing then click on [Window] -> [Open Perspective] -> [Other…] and select 
Java EE perspective. 

Once the perspective is selected, click the [Servers] tab at the bottom of the window as shown 
below.  See Figure 42. 
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Figure 41 

 

Configuration If the Servers tab is not showing, then click [Windows] -> [Show View] -> [Other…]. 

In the popup window find [Server], expand, and click on [Servers].  See Figure 43. 

 

 
Figure 42 

 

 Click the [new server wizard…] link.   

Configuration Or right click within the Server tab panel and select New  Server.  It does the same 
thing as clicking the wizard link. 
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Expand the [JBoss Community] folder, and select [JBoss AS 5.1] as shown.  See Figure 44. 
 

 
Figure 43 

 

Press [Next] to continue. 



Eclipse Developer’s Manual 

Version 1.21 06/04/2014 39 
 

Now you need to specify the Home Directory, as shown below. 

And confirm that the JRE is set to correct version: 

MAC OS: Java SE 6 (MacOS X Default) 
Windows:  jre6 

In Configuration, the Directory will be server. 

And make sure “default” is highlighted.  See Figure 45. 
 

 
Figure 44 

 

Click [Finish]. 
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Double click on the new added server name on the server tab to open the properties folder.  See 
Figure 46. 
 

 
Figure 45 

 

The following window will appear.  See Figure 47. 
 

 
Figure 46 

 

Expand the “publishing” section.  Adjust the settings for publishing, setting it to “Never publish 
automatically”.  See Figure 48. 
 

 
Figure 47 
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Expand the “timeouts” section.  Adjust the settings for timeout, setting start value to 999, setting 
stop value to 001.  See Figure 49. 
 

 
Figure 48 

 

Save the settings before continuing. 

Click on the [Deployment] tab at the bottom of the JBoss Overview window.  

Set the option for “Use the JBoss deploy folder”.  See Figure 50. 
 

 
Figure 49 

 

Make sure the “Deploy projects as compressed archives” is checked.  See Figure 51. 
 

 
Figure 50 

 

[Save] the settings to complete this task.   
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5.11.8 Clean Up the JBoss Server Directory 

Procedure: 
Look in the File system under the JBoss installation directory: 

 /EclipseWorkbench/jboss-5.1.0.GA/server/default 

Look for a file or a directory named: ROOT.war.  If that file or directory exists you must delete 
it. 

Caution ROOT.war must be deleted if it exists.  Otherwise you will get a Deployment Exception later 
in the process   

 

5.11.9 Initial Flex Configuration 

Procedure 
Navigate to the [Eclipse]  [Preferences] screen.   

Then expand Flash Builder.  See Figure 52. 
 

 
Figure 51 

 

Click on [Installed Flex SDKs].  Make sure that Flex 3.6A is selected. 

[Apply].  Click [OK]. 

Caution Do not select Flex4.6 as MTS is not ready to migrate to 4.6. 
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5.12  Connect to MTS Subversion Repository 
The next step is to checkout code from the SVN.  

This sub-process requires connection to the SVN and checkout code from the devl branch.  
Remember that the Eclipse workspace being used is in 

/EclipseWorkbench/workspaces/devl.   
 

Configuration If you want to checkout test or production code, switch workspace to: 

/EclipseWorkbench/workspaces/prod (For Production) or  

/EclipseWorkbench /workspaces/test (Test Code).   

 

You will require a username and password to connect to the repository.  If you do not have one, 
please contact the SVN administrator. 

Procedure: 
Open the SVN Repository Exploring Perspective by selecting [Window] from the menu bar.  
Select [Open Perspective]  [Other..].   

Choose SVN Repository Exploring.  See Figure 53. 
 

 
Figure 52 

 

This will cause a new tab to show up in the Workspace.  See Figure 54. 
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Figure 53 

 

You will automatically be directed to this window.  See Figure 55. 
 

 
Figure 54 

 

Right click within the SVN Repositories panel and select [New]  [Repository Location…]. 

Enter the SVN URL to checkout code from devl. 

Contact MTS Technical Support for the location of the current MTS Repository. 

See Figure 56 (This is a sample only). 
 



Eclipse Developer’s Manual 

Version 1.21 06/04/2014 45 
 

 
Figure 55 

 

It will ask for your username and password.  If you do not have one, please contact MTS 
Technical Support. 

Expand the newly added repository under the SVN Repositories tab as shown in Figure 57.  
 

 
Figure 56 

 

To continue, select MTS_APP, MTS_EJBApp, MTS_WebApp, MTCSE_Flex, and 
MTCSE_Reports from the list and right-click and [Checkout].  See Figure 58. 

 
Figure 57 
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You will be presented the Checkout Dialog box.  See Figure 59 
 

 
Figure 58 

 

Click [Finish] to checkout code. 

You will see the progression of the code being checked out.  See Figure 60. 
 

 
Figure 59 

 

This step may take some time.  (5-10 minutes, depending on network and computer speeds) 
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5.13 Set-up of Runtime Dependent Jar Files 
Certain jar files/libraries are required to develop and run the application.  This sub-process will 
provide you with the base files that will need to be setup.  

Procedure 
In the EclipseWorkbench folder, create a folder named SVNco_tobedeleted.  

Login to Alfresco server http://cms.sysdvl.com/alfresco/, then obtain the following zip file:  
env_script.zip found at: 

Company Home > 1 Model Tribal System > 2 MTS Systems Documentation > 9 Development > 
Configuration Files. 

Place the scripts.zip file under the SVNco_tobedeleted folder and uncompress/unzip. 

You should see a structure that looks like Figure 61 when completed.   
 

 
Figure 60 

http://cms.sysdvl.com/alfresco/
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Once the checkout process has completed, copy all the jar files.  

 

File Copy: 

 /EclipseWorkbench /SVNco_tobedeleted/scripts/lib/  

to 
 /EclipseWorkbench /jboss-5.1.0.GA/server/default/lib 

 

This will take care of the Hibernate, common, and MySQL jars that are required.  Those libraries 
are NOT bundled in the WAR or EAR file, and are therefore only deployed on the server. 

Here is the list as of this publication.  See Figure 62 
 

 
Figure 61 

 

Ensure all required files are listed before continuing to the next sub-process. 

Close eclipse. 

Configuration If you do not have access to the Alfresco directory above, then you can find all these 
jar files on the internet by using the tool:   

http://www.jarfinder.com/index.php/jars 

 

 

 

http://www.jarfinder.com/index.php/jars
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5.14 Update Flex SDK Settings in Files 
We now need to adjust the settings of two files before we proceed: 

Procedure: 

Caution Make sure Eclipse is closed!! 

 
In your terminal/command window go to:  

/EclipseWorkbench/Workspaces/devl/MTCSE_Flex 
Then edit the following file:  .actionScriptProperties 

Caution When editing files, make sure you use an editor that will not introduce invisible characters.  It 
is best to use either vi on the MAC or Notepad on Windows.  On Windows you may wish to 
change your settings on whether or not extensions are hidden on files.  

 

Find the reference to flexSDK="Flex 3.6" and change it to flexSDK="Flex 3.6A" if necessary 

See Example Figure 63. 
 

 
Figure 62 

 

Then go to: 
/EclipseWorkbench/Workspaces/devl/MTCSE_Flex/.settings 

And edit the file:  com.adobe.flexbuilder.project.prefs 
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Change the line from upgradeSDK/fb4=Flex 3.6 to upgradeSDK/fb4=Flex 3.6A if necessary 

 

5.15 Adjust Project Settings 
Procedure: 
Open Eclipse, and go to the Java EE Perspective.  See Figure 64. 
 

 
Figure 63 

 

Next, go to the Project Explorer.  See Figure 65. 
 

  
Figure 64 

 

5.15.1 MTCSE_EJBApp 

In the J2EE perspective, right-click on MTCSE_EJBApp and click [Properties]. 

In the properties dialog window, right click on “MTCSE_EJBApp” and select [properties]. 

Then select Java Build Path. 

Click on [Libraries]. 

Click on [Add External Jars]. 

Select all the Jars under:  /EclipseWorkbench/jboss-5.1.0.GA/server/default/lib (See Figure 66). 

Then click [Open]. 
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Figure 65 

 

Next resolve any Java conflicts: 

Again under the Libraries section, select “JRE System Library…” and click [Edit…]. 

See Figure 67. 
 

 
Figure 66 

 

For the JRE System Library, select the Workspace default radio button. 

See Figure 68. 
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Figure 67 

 

Click [Finish]. 

Click on [Targeted Runtimes] and set it to the JBoss 5.1 Runtime.  See Figure 69. 
 

 
Figure 68 

 

Click [Apply] 

Click on [Server]. Set the Server to JBoss 5.1 Runtime Server. 

See Figure 70. 
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Figure 69 

 

Click [Apply]. 

Click [OK]. 

 

5.15.2 MTCSE_App 

In the J2EE perspective, right-click on MTCSE_App and click [Properties]. 

In the properties Dialog window, click on [Targeted Runtimes] and set it to the JBoss 5.1 
Runtime.  See Figure 69. 

Click [Apply]. 

Click on [Server]. Set the Server to JBoss 5.1 Runtime Server. 

See Figure 70. 

Click [Apply]. 

Click on [Java Build Path].  On right side click [Libraries] tab.   

In the window below, it should say [JRE System Library    ….  ]. 

Click on that line.  The on the right side click [Edit]. 

On the popup window make sure that it has the [Workspace Default ….] radial button selected. 

Click [Finish]. 

Click [Apply]. 

Click [OK]. 
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5.15.3 MTCSE_WebApp 

These steps are identical to the ones for MTCSE_EJBApp, except we are making them on the 
MTCSE_WebApp project. 

In the J2EE perspective, right-click on MTCSE_WebApp and click [Properties]. 

In the properties Dialog window.  

Then select Java Build Path. 

Click on [Libraries]. 

Click on [Add External Jars]. 

Select all the Jars under:  /EclipseWorkbench/jboss-5.1.0.GA/server/default/lib (See Figure 66) 

Then click [Open]. 

Next resolve any Java conflicts: 

Again under the Libraries section, select “JRE System Library…” and click [Edit…]. 

See Figure 67. 

For the JRE System Library, select the Workspace default radio button. 

See Figure 68. 

Click [Finish]. 

Click on [Targeted Runtimes] and set it to the JBoss 5.1 Runtime.  See Figure 69. 

Click [Apply]. 

Click on [Server]. Set the Server to JBoss 5.1 Runtime Server. 

See Figure 70. 

Click [Apply]. 

Click [OK]. 

 

5.15.4    MTCSE_Flex 

Procedure: 
Right Click on the MTCSE_Flex project [Properties]. 

In the dialog box, find [Flex Build Path]. 

See Figure 71. 
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Figure 70 

 

Look to see if the flex_lib folder is listed on the right hand side under the Build path libraries. 
 

 
 

If flex_libs is NOT there then follow the following steps: 

Click [Add SWC Folder…]. 

It will display a Browser box.  See Figure 72. 
 

 
Figure 71 
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Browse and search for the location of the flex_lib directory under the MTCSE_Flex directory.  
See Figure 73 
 

 
Figure 72 

 

Click [Open] 

When done it should look like Figure 74. 
 

 
Figure 73 

 

5.15.5 MTCSE_Reports  

Right click on MTCSE_Reports - > Properties. 
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In the properties window, click [Jaspersoft Studio]. 

Then on the right hand side select the [User Project Settings] radio button. 

For the Version select [JasperReports 3.7.5]. 

And check the box [Show Compatibility warning dialog].  See Figure 75 
 

 
Figure 74 

 

Click [Apply] and then [OK]. 

Close Eclipse. 

Next take the zip file MTSFonts.zip, found under the 
/EclipseWorkbench/Workspaces/devl/MTCSE_Reports/studio_files directory, and unzip that 
directory to /EclipseWorkbench/MTSFonts 
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5.16 Optional Eclipse Configuration 
You may want to make the following additional Eclipse configuration changes. 

 

5.16.1 Turn On Line Number in Editor Windows 

Procedure: 
Eclipse -> Preferences (MAC OS) or Windows ->Preferences (Windows).  In the dialog, under 
General, find Editors->Text Editors.  See Figure 76 
 

 
Figure 75 

 

Then check the box next to “Show line numbers”. 

Click [OK]. 

 

5.16.2 Adjust the Warnings/Errors Displayed 

Procedure: 
Make sure you are in the [Java EE] Perspective. 

Open the Problems View.  Select [Windows] -> [Show View] -> [Other…]. 

Go to [General] -> [Problems]. 
The problems tab will appear in the bottom of the eclipse application. 
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In the upper right corner of the Problems window, click on the triangle, then on [Configure 
Contents…].   See Figure 77. 

 
Figure 76 

 

In the pop up that follows, make the following changes.  See Figure 78. 

Under Configurations, select “Errors/Warning on Project”. 

Under Scope, select “On selected element and its children”. 
 

 
Figure 77 

 

In the “Types” area first [Deselect All]. 
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Then click on only those that begin with Java, Flash, or Flex. 

Caution Picture above does not show all the Types you want to select. 

Scroll up to find the Flash or Flex types. 

 

When done click [OK] 

 

5.16.3 Adjust Java Compiler Warning 

Procedure: 
In the Preferences popup window, make adjustments to java -> Java compiler -
>Errors/Warnings. 

Under the [Generic Types] category: 

Change the level of “Unchecked Generic Type Operations” from Warning to Ignore. 

Change the level of “Usage of Raw Type” from Warning to Ignore. 

See Figure 79. 

Click [OK]. 
 

 
Figure 78 
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6 Application Configuration 
In this section we setup the application, and customize settings like mail preferences, database 
connections, etc. 

Caution Warning!! 

Warning!! 

This is not a direct copy.  Note that the extension of the files  changes  from “.xml.template” to 
just “.xml” 

Or “.properties.template”  to  just “.properties” 

Drop the “.template” !!! 

 

6.1 Install Dependent Files for the Application 
The primary mechanism is to take templates of properties that you downloaded earlier into the 
SVNco_toBeDeleted directory, and copy them into the JBoss Server directories.  Afterwards, to 
make any adjustments to the parameters, like passwords, etc. 

 

Procedure 

6.1.1 Install Basic Application Properties 

File Copy: 
/EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/conf/applications.properties.template 

 to  
/EclipseWorkbench/jboss-5.1.0.GA/server/default/conf/application.properties 

 

Configuration Configuration in this file is to support the feature where MTS will send an email to a 
specified user when an exception is thrown in the log file.  If you do not have access to 
an SMTP server, you can still proceed and launch the application without configuring 
this file. 

 

Adjust the mail server properties for the application. 

Go through the application.properties file and add in the correct values for variables surrounded 
in %% signs.  For example:  %smtp_server% would become smtp.comcast.net (make sure to 
replace the %% too!!) 

Sample input (words in yellow were modified): 
# Your Mail Configuration details  

SMTP_SERVER=smtp.comcast.net 
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MAIL_AUTH_ID=mtsuser 

MAIL_PASSWORD=rabbit 

MAIL_FROM=mydev@mailinator.com 

# Technical Support 

TECH_SUPPORT=pinky@brain.com 

LOAD_CACHE_ON_STARTUP=true 

TRANSPOST_LOG=false 

SEND_MAIL_ON_ERROR=true 

Meanings of the settings: 

SMTP_SERVER = the server that you application can use to send an email. 

MAIL_AUTH_ID = the username required for the above server. 

MAIL_PASSWORD = the password that goes with the user for the SMPT server. 

MAIL_FROM = what mail address should the email sent show in the “from” line.  This 
address does not have to be real, but must be properly formed and meet all the 
qualifications of an email address. 

TECH_SUPPORT = the person or group to which mail will be sent when an error is 
encountered in the system. 

6.1.2 Install Quartz Jobs File 

File Copy: 
/EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/conf/mtcse_quartz_jobs.xml.template 

to  
 /EclipseWorkbench/jboss-5.1.0.GA/server/default/conf/mtcse_quartz_jobs.xml 

Modification of this file is NOT necessary. 

File Copy: /EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/conf/jbossts-
properties.xml.template 

to  
 /EclipseWorkbench/jboss-5.1.0.GA/server/default/conf/ jbossts-properties.xml 

Modification of this file is NOT necessary. 
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6.1.3 Install Messaging Service 

 

File Copy: 
/EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/deploy/messaging/messaging-
service.xml.template   
to  
/EclipseWorkbench/jboss-5.1.0.GA/server/default/deploy/messaging/messaging-service.xml.   

 

Modification of this file is NOT necessary. 
However you should be aware that there is a password in this file for the configuration of the 
JBoss messaging service. 

 
Figure 79 

 

6.1.4 Install Configuration for Message Labels 

 

File Copy: /EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/deploy/messaging 
/messaging-jboss-beans.xml.template 

  to 
/EclipseWorkbench/jboss-5.1.0.GA/server/default/deploy/messaging/messaging-jboss-
beans.xml.   

 

Modification of this file is NOT necessary; however you should be aware that there is a 
password in this file for the configuration of the JBoss messaging service. 

Make sure that the password entered here matches the password for the messaging-service.xml file 
above. 
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  <property name=”suckerPassword”>bandit</property> 

File Copy: /EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/deploy/messaging 
/destinations-service.xml.template   

to  
/EclipseWorkbench/jboss-5.1.0.GA/server/default/deploy/messaging/destinations-
service.xml.   

Modification of this file is NOT necessary. 

 

6.1.5 Configuring the MySQL and Mail Services 

 

File Copy: /EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/deploy/mysql-
ds.xml.template 

to  
 /EclipseWorkbench/jboss-5.1.0.GA/server/default/deploy/mysql-ds.xml. 
 

Modification: Modify the mysql-ds.xml file to support connectivity to the local DBMS by 
changing the values for database username and password, and database name to match what has 
been setup for your database.   

We will also configure to use an XA datasource instead of a local tx datasource. 

In this exercise we will name the database “mts” the username we will keep as “root” and the 
password will be your root password for the MySQL database. 

So your file should look like this: 
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<xa-datasource> 

 <jndi-name>MySqlDS</jndi-name> 

 <min-pool-size>5</min-pool-size> 

    <max-pool-size>100</max-pool-size> 

 <xa-datasource-class>com.mysql.jdbc.jdbc2.optional.MysqlXADataSource</xa-
datasource-class> 

 <xa-datasource-property name="URL">jdbc:mysql://localhost:3306/mts</xa-
datasource-property> 

 <xa-datasource-property name="User">root</xa-datasource-property> 

 <xa-datasource-property name="Password">Bandit99</xa-datasource-property> 

   </xa-datasource> 
 

Figure 80 

Use the password that you used instead of “Bandit99”. 

Caution Put the password you created for your MySQL root account in as the password! 

 
 

6.1.6 Install Mail Service Configuration 

File Copy: /EclipseWorkbench/SVNco_toBeDeleted/scripts/templates/mail-
service.xml.template 

 to  
/EclipseWorkbench/jboss-5.1.0.GA/server/default/deploy/mail-service.xml. 

Modification: Modify the mail-service.xml to support connectivity to the current mail server 
and SMTP user authentication.  

Configuration Configuration in this file is to support the feature of sending documents or reports to 
a user.  If you do not have access to an SMTP server, then you can skip this section 
and just will not be able to email a report. 

 

A sample follows: (words in yellow were modified) 

<configuration> 
        <!-- Change to your mail server prototocol --> 
        <property name="mail.store.protocol" value="pop3"/> 
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        <property name="mail.transport.protocol" value="smtp"/> 
        <!-- Change to the user who will receive mail  --> 
        <property name="mail.user" value="pinky@brain.com"/> 
        <!-- Change to the mail server  --> 
        <property name="mail.pop3.host" value="pop.comcast.net"/> 
        <!-- Change to the SMTP gateway server --> 
        <property name="mail.smtp.host" value=" smtp.comcast.net "/> 
         
        <!-- The mail server port --> 
        <property name="mail.smtp.port" value="25"/> 
         
        <!-- Change to the address mail will be from  --> 
        <property name="mail.from" value="mydev@mailinator.com"/> 
        <!-- Enable debugging output from the javamail classes --> 
        <property name="mail.debug" value="false"/> 
      </configuration> 
 

6.2 Install MySQL 5.1 

Caution Perform these steps to upgrade to MySQL 5.1.  If you are currently running MySQL 5.1 or 
greater, then do not perform these steps.  

Of course, if you don’t have MySQL installed you won’t be able to do this. 

To find what version of MySQL is running:  

• Login to MySQL from command prompt 
  mysql –uroot –p 

• You will be prompted for the password 

• Execute query 
SELECT version(); 
See Figure 82 
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Figure 81 

 

6.2.1 Uninstall MySQL (only if installed previously with a lower version) 

Procedure: 
First backup your database using the following command.  For all databases (from the 
/usr/local/mysql/bin directory): 

 mysqldump -u username -ppassword –all-databases > [filename].sql 
or, for multiple databases 

 mysqldump -u username -ppassword –databases db_name1 [db_name2 ...] > 
[filename].sql 
or for a single database 

mysqldump -u username -ppassword database_name > [filename].sql 
 

Caution Make sure to write the dump files to a location outside of the /usr/local/msql directory 
structure, as we will be deleting that directory structure.  

 

6.2.1.1 Shutdown MySQL 

 

6.2.1.1.1 MAC OS 

Use System Preferences or using the following command: 

 sudo /usr/local/mysql/bin/mysqladmin –uroot –p shutdown 
 

6.2.1.1.2 Windows 
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Use The Services.  

6.2.1.2 Delete the MySQL files from the various directories 

 

6.2.1.2.1 MAC OS 

Using the terminal execute the following commands: 

sudo rm /usr/local/mysql 
sudo rm -rf /usr/local/mysql* 
sudo rm -rf /Library/StartupItems/MySQLCOM 
sudo rm -rf /Library/PreferencePanes/My* 
(Edit /etc./hostconfig) sudo vi /etc./hostconfig (Remove line MYSQLCOM=-YES) 
sudo rm -rf /Library/Receipts/mysql* 
sudo rm -rf /Library/Receipts/MySQL* 
sudo rm -rf /var/db/receipts/com.mysql.*  
 

6.2.1.2.2 Windows 

Use the MySQL Installation tool.  This will automatically remove old database files. 

6.2.2 Install MySQL  

 

6.2.2.1 MAC OS 

Choose the DMG file to download for your Mac (we assume the 64 bit for MAC OS X 10.6 or 
higher). 

Execute the DMG file to load the disk image.  Within the MySQL disk image, run the mysql-
5.1.56-oxs10.6-x86_64.pkg package to install MySQL.  See Figure 83 

 

 
Figure 82 

 

Follow the wizard to complete the install of MySQL. 

Once the install is complete, run the MySQLStartupItem.pkg package to allow MySQL to start 
on system startup. 
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Double click [MySQL.prefPane] to install the preference pane MySQL monitor. 

 

6.2.2.2 Windows 

Use the mySql installation tool.  And Allow it to [Run] (See Figure 84) 

 
Figure 83 

 

Confirm permission to run the tool. Click [Yes]. 

See Figure 85. 
 

 
Figure 84 

 

Install will automatically launch the WebInstaller tool. 

You may have to confirm permission to run this tool.  If you do then just click [Yes]. 

See Figure 86. 
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Figure 85 

The system will take some time to evaluate current conditions.  See Figure 87. 
 

 
Figure 86 

 

6.2.2.2.1 No Previous MySql products on system 

If you have never installed any MySql applications on your system you will see the following 
window appear.  See Figure 88. 
 

 
Figure 87 

 

Click on the [Install MySQL Products] link. 
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If you see a different window then skip this section and proceed to section 6.2.2.2.2 below. 

It will ask you to agree to the license.  See Figure 89. 

 
Figure 88 

 

Next it will want to look for updates.  See Figure 90.  Just click the checkbox next to [Skip] and 
then click [Execute]. 
 

 
Figure 89 

 

Next it will want you to configure some setup parameters, See Figure 91.  Click the [Custom] 
radial button, and change the path for the Data to 5.1 instead of 5.6. 
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Before: 

 
Figure 90 
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After: 

 
Figure 91 

 

Click [Next > ]. 
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Now on the Feature Selection screen, you will see a pick list and underneath is configuration for 
the selected item.  By default it will come up to the most current version of MySQL server. 

Make sure that the checkbox next to MySQL 5.6.11 is NOT selected.  See Figure 93 

You may want to also uncheck the Documentation for 5.6.11. 
 

 
Figure 92 

 

Then change the pick list value to MySQL 5.1 Community Edition. 

In the window below (Figure 94), make sure that you select the checkbox next to MySQL 5.1 
Community Edition. 
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Figure 93 

 

Make sure that Applications and MySQL Connections is also selected. 

Click [Next >]. 

The system will now display the required applications/tools.  And which are installed and not 
installed.  See Figure 95. 

Click [Execute] and install any missing tools. 
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Figure 94 

 

The system will show you exactly what will be installed.  See Figure 96. 

Make sure that MySQL 5.1.68 is either “To be downloaded” or “To be installed” and that 
MySQL 5.6.11 is NOT on the list.  Click [Execute] 
 

 
Figure 95 
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The system might have to download the Server.  See Figure 97. 
 

 
Figure 96 

 

Proceed to 6.2.2.2.3 below. 

 

6.2.2.2.2 Previous MySQL Products installed 

If you happen to have any MySQL products installed already you will see an option to update, 
but you want to pick the [Add/Modify Products and Features].  See Figure 98. 
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Figure 97 

 

Caution Don’t use the [Install updates] option. 

 

The installer window will appear. 

There is a product Catalog pick list.  You select the options you want installed for the current 
catalog item selected. 

By default it will come up to the most current version of MySQL server. 

Make sure that the checkbox next to MySQL 5.6.11 is NOT selected.  See Figure 99. 

You may want to also uncheck the Documentation for 5.6.11. 
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Figure 98 

 

Then change the pick list value to MySQL 5.1 Community Edition.  See Figure 100. 
 

 
Figure 99 

 

In the window below (Figure 101), make sure that you select the checkbox next to MySQL 5.1 
Community Edition. 

Make sure you select the correct version of MySQL.  We want 5.1!! 
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Figure 100 

 

Caution Did you select MySQL 5.1? 

 

Click [Next >] 

Now you will be taken to the requirements screen.  Click [Next].  System will begin to install all 
the required material if not already installed. 

 

6.2.2.2.3 Configuration 
On page one, make sure to select Developer Machine, and to select the Show Advanced Options 
check box.  See Figure 102  
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Figure 101 

 

Page 2: 

Enter the password for the root user.  See Figure 103. 
 

 
Figure 102 
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Page 3: 

Leave the Start the MySQL Server at System Startup checkbox blank.  See Figure 104. 

 
Figure 103 

Page 4: 

Choose which logging options you want.  See Figure 105. 

 
Figure 104 

And now the server will finish the configuration.  See Figure 106 



Eclipse Developer’s Manual 

Version 1.21 06/04/2014 83 
 

 
Figure 105 

 

Click [Next >] and wait for it to finish. 

Configuration The default installation will be:  C:\Program Files\MySQL\MySQL Server 5.1\ 
  

6.2.3 Start MySQL  

 

6.2.3.1 MAC OS 

Open system preferences and double click on the MySQL preference pane under “Other”.  See 
Figure 107 
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Figure 106 

 

Start MySQL by clicking on the [Start MySQL Server] button.  See Figure 108.  This will prompt 
you for your system password. 
 

 
Figure 107 
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If MySQL started successfully, the panel should now look like Figure 109 (green “running”).  
 

 
Figure 108 

 

6.2.3.2 Windows 

Click start and search for Services.  See Figure 110. 
 

 
Figure 109 

 

Click the [Services] Program. 

In the resulting application window that pops up (Figure 111), search and select MySQL51. 

Then click the [Start] link on the left. 



Eclipse Developer’s Manual 

Version 1.21 06/04/2014 86 
 

 
Figure 110 

 

6.2.4 Secure the MySQL Installation (MAC OS only) 
Procedure: 

Secure the MySQL installation by setting the root password, deleting anonymous users, and 
dropping the test database.  This can be done through the included utility, 
mysql_secure_installation located in the mysql/bin directory.   

 

Caution In order to run this you must be in the /usr/local/mysql directory or it will fail. 

 

 cd /usr/local/mysql 
 sudo bin/mysql_secure_installation 
Follow the prompts on the screen to set the root users password, delete anonymous users, delete 
the test database, and flush the privileges.  Enter yes to all of these. 
 

Caution The first time through, the root user’s password is blank. 

 

6.2.5 Configuring source files for various jars 

 
For example if you want to be able to step through jasper reports execution and debug issues. 
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Get the source file jar from: 
http://grepcode.com/snapshot/repo1.maven.org/maven2/net.sf.jasperreports/jasperreports/5.0.1 
 
Put the source file  on your system.  It can be anywhere, but I recommend 
/EclipseWorkbench/sources/. 
Next you have to go to the project eclipse that includes the jar. 
 
In this case the MTCSE_Webapp project.  Click on the project, and then right click to open the 
properties: 
 

 
 
In the properties Window that pops up, select Java Build Path and the Libraries tab. 
 

http://grepcode.com/snapshot/repo1.maven.org/maven2/net.sf.jasperreports/jasperreports/5.0.1
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Then find your jar file. 
 
It might be listed directly, like the commons-codec.jar, or it might be included in another folder.  
For example in this situation it’s in the “Web App Libraries” folder. 
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Expand the jar file and highlight the “Source attachment” line.   Then click “Edit…” 
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In the Dialog box, select “External location”, then find the source jar file using “External File…” 
 
Then after you have selected it hit [OK]. 
 
Then hit [OK] on the previous window.    
 
You should now be configured to debug into the source file of the jar you selected. 
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7 Prepare, Deploy, and Launch the Application  
In all the below, we will be using a lot of command line entries. 

Since the MySQL root directory varies from Windows to Mac, We use the following convention: 

<mysql_path> which should be replaced with the path based on your deployment 

MAC OS:  /usr/local/mysql 
Windows:  C:\Program Files\MySQL\MySQL Server 5.1 

For example: 

<mysql_path>/bin/mysql     
 becomes 

in MAC OS: 

               /usr/local/mysql/bin/mysql 
in Windows:  

              C:\Program Files\MySQL\MySQL Server 5.1\bin\mysql 
 

Caution The user is encouraged to adjust their path settings so that MySQL will be available without 
having to enter the complete path. 

 

7.1 Create the DB Instance 
If you installed a new db then you must create the db instance. 
Procedure: 

From the command line type 

 <mysql_path>/bin/mysql –uroot –p  
Enter your password when prompted. 

At the MySQL prompt create the database. 

 mysql> create database mts; 
 

Caution Remember we are creating our database to be mts so for this document you should use: 

mysql> create database mts 

 

7.2 Reload Database 
If you had a previous version of MySQL loaded, then you may wish to reload the databases.  But 
we encourage you to move on to 7.3 and get the most recent version of the db to load. 
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If re-using the previous schema, reload the databases backed up in step one.   
Procedure: 

Exit MySQL and navigate to the directory where you backed up your files from the command 
line.  Once there, you can use the following commands to load your database. 

<mysql_path>/bin/mysql –uroot –p [database name] < [your file].sql 
 

7.3 Blank Schema or Most Current DB for Deployment 
If you are using a new blank schema or just want the most current db for deployment, you can 
get a copy of the current db script from the DSTS administrator.  As of this publication contact 
Tom Mahony   tom.mahony@acf.hhs.gov 

Unzip the archive you receive. 

Caution For Windows you may have to download a tool to un-compress the GNU Zip file.  I 
recommend 7-zip, which is free. 

 

Then in a terminal/command window  run: 

<mysql_path>/bin/mysql –uroot –p mts < [your file] 
For example: 
/usr/local/mysql/bin/mysql –uroot –p mts < 60_cases_plus_fin.sql 

Next you must start the MySQL program so that you can run a few scripts. 
In a terminal/command window run: 

<mysql_path>/bin/mysql –uroot –p 
At the “mysql>” prompt execute the following commands: 

mysql> update mts.cmmn_user set cus_reset_passwd_dte = adddate(now(), interval 1 year); 
You should get a response saying that so many rows were affected:  

Query OK, 59 rows affected, 59 warnings (0.06 sec) 

Rows matched: 59 Changed: 59 Warnings: 59 

Next type this command: 

mysql> commit; 
Then execute this one: 

mysql> update mts.cmmn_user_role set cur_end_dte = adddate(now(), interval 1 year); 
Commit again: 

mysql> commit; 
And finally execute this command: 

mysql> GRANT ALL on *.* to 'diff'@'192.168.102.%' identified by '9876543d2'; 

mailto:tom.mahony@acf.hhs.gov
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Then exit; 

mysql> exit 
 

7.4 Install GUI Tool to View MySQL database. (Mac OS only) 

Configuration Windows deployment automatically loads the MySQL workbench. 

Procedure: 
Install the MySQL Workbench using the mysql-workbench-gpl-5.2.47-osx-i686.dmg. 

 

7.5 Verify Structure/Data Was Loaded 
Procedure: 
Use the MySQL Workbench, and open connection to the MySQL database and verify that the 
data was loaded. 

 

7.6 Build Application 
Procedure: 
Open Eclipse.   

Click [Project] -> [Clean ..] 

See Figure 112 
 

 
Figure 111 

In the popup that follows (Figure 113), click the Clean All Project radio button, and then click 
[OK]. 
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Figure 112 

 

This can take 15+ minutes, depending on the speed of the machine.  A Dialog box will show the 
progress.  See Figure 114 
 

 
Figure 113 

 

Dialog box will close when the build is complete. 

 

7.7 Deploy the Application 
Procedure: 
Right click on the JBoss Server, under the Server tab.   
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Select Add and Remove,  

 

 
 

On the dialog that pops up.  See Figure 115 

Select MTCSE_App from the available resource and click the [Add>>] button.   

Click [Finish]. 
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Figure 114 

Now right-click on JBoss 5.1.0 server to bring up the menu items.  See Figure 116.  Click 
[Clean…]  
 

 
Figure 115 
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7.8 Start the Application 
Procedure: 
Click on the Go button (See Figure 117), or use the Menu. 
 

 
Figure 116 

 

Review the console for errors.   

If all goes well the final line should look much like Figure 118: 
 

 
Figure 117 

 

The key thing to note is that “Starting Coyote HTTP … on … localhost..” and “Starting Coyote 
AJP … on … localhost…”  are displayed in the log.  This means that the server is up and 
running.  

 

7.9 Smoke Test the Application 
Next check that the Application works: 

Procedure: 
In a browser open the following URL: 

http://localhost:8080/ 

You should see the application as in Figure 119.  
 

http://localhost:8080/
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Figure 118 

 

If you used the 60 cases db, then enter a sample User ID and Password: 

User ID:  kkear1 

Password: kay1 

 

7.10 Setup Eclipse for Client side Flex Debugging 
It is assumed that your server is already running from above (Either in normal or debug mode).  
These instructions are specifically to allow you to debug the client side Flex code MXML or 
ActionScript files. 

To use your IDE as a debugging tool for the flex side, you will need to do the following: 

From either the [Java EE] or [Flash] Perspectives, you will see a list of icons at the top of the 
screen.  See Figure 120 
 

 
Figure 119 

 

Click on the triangle just to the right of the green “bug”. 
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Click on [Debug Configurations…].  See Figure 121 
 

 
Figure 120 

 

In the Window that pops up (See Figure 122): Click [Web Application], then click the New icon. 

 
Figure 121 

On the right hand side (see Figure 123): Enter a name for this configuration “Flex debug” 
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[browse] and find the Application:  MTCSE_Flex. 

In the section URL or path launch, uncheck the default checkbox, and enter in the text box 
below:  http://localhost:8080/ 
 

 
Figure 122 

http://localhost:8080/
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Then click the “Common” tab (See Figure 124), and on that screen in the display in favorites 
menu, check [Debug]. 
 

 
Figure 123 

 

[Apply] and [Close] 

Make sure that the Server is running. 

Caution You can start the server in either debug, or normal mode.  If you want to debug both Server 
side and Client side simultaneously then start the server in debug mode before you launch this 
debug. 

Now go back and click that triangle next to the green bug again.  See Figure 125 
 

 
Figure 124 

 

Our configuration is present. 

Click [Flex Debug]. 
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The application will start up, and a browser will automatically be launched. 

If your system default browser does not support Flash debugging, then you will have to change 
your default to either Firefox or IE, or something that is compatible. 

When debugging this way, you may wish to modify the timeout for the browser, when waiting 
for the procedure to finish. 

 

7.10.1 Safari Browser Setup 

In MacOS,  Open Terminal 

Type: 

defaults write com.apple.Safari WebKitDisablePluginProcessMessageTimeout YES 
Restart Safari. 

 

7.10.2 Firefox Browser Setup 

In the browser’s address bar type: 

about:config 
Click the “I’ll be careful” button in the warning dialog and then scroll down to this line: 

dom.ipc.plugins.timeoutSecs 
Double click on that line and set the value to -1 

 

7.11 Adding jdbcdslog Support 
It is often useful for a developer to see the SQL queries that are being made to the database, to 
either validate their correctness or do other profiling tasks. 

jdbcdslog is a seamless integration that allows the developer to see the actual queries made, with 
parameters, in the console.  For example: 
 

2014-01-28 13:02:00,026 INFO  [org.jdbcdslog.StatementLogger] (MTCSEScheduler_Worker-
8) java.sql.PreparedStatement.executeQuery select this_.PTR_ID as PTR1_43_0_, 
this_.PTR_CREATEDBY_NM as PTR2_43_0_, this_.PTR_CREATEDTIME_DTE as PTR3_43_0_, 
this_.PTR_DOC_DATA_BLB as PTR4_43_0_, this_.PTR_DOC_LOC_TXT as PTR5_43_0_, 
this_.PTR_DOC_NM_TXT as PTR6_43_0_, this_.PTR_JOB_STAT_CD as PTR7_43_0_, 
this_.PTR_KEY_TXT as PTR8_43_0_, this_.PTR_KEY_VALUE_TXT as PTR9_43_0_, 
this_.PTR_MIMETYPE_TXT as PTR10_43_0_, this_.PTR_PRINT_PARMS_TXT as PTR11_43_0_, 
this_.PTR_PRTR_NM_TXT as PTR12_43_0_, this_.PTR_UPDATEDBY_NM as PTR13_43_0_, 
this_.PTR_UPDATEDTIME_DTE as PTR14_43_0_ from print_request this_ where 
(this_.PTR_JOB_STAT_CD=?) parameters: ['Pending'] 1 ms. at 
org.jboss.resource.adapter.jdbc.WrappedPreparedStatement.executeQuery(WrappedPreparedS
tatement.java:342) 

2014-01-28 13:03:00,018 INFO  [org.jdbcdslog.StatementLogger] (MTCSEScheduler_Worker-
9) java.sql.PreparedStatement.executeQuery select this_.PTR_ID as PTR1_43_0_, 
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this_.PTR_CREATEDBY_NM as PTR2_43_0_, this_.PTR_CREATEDTIME_DTE as PTR3_43_0_, 
this_.PTR_DOC_DATA_BLB as PTR4_43_0_, this_.PTR_DOC_LOC_TXT as PTR5_43_0_, 
this_.PTR_DOC_NM_TXT as PTR6_43_0_, this_.PTR_JOB_STAT_CD as PTR7_43_0_, 
this_.PTR_KEY_TXT as PTR8_43_0_, this_.PTR_KEY_VALUE_TXT as PTR9_43_0_, 
this_.PTR_MIMETYPE_TXT as PTR10_43_0_, this_.PTR_PRINT_PARMS_TXT as PTR11_43_0_, 
this_.PTR_PRTR_NM_TXT as PTR12_43_0_, this_.PTR_UPDATEDBY_NM as PTR13_43_0_, 
this_.PTR_UPDATEDTIME_DTE as PTR14_43_0_ from print_request this_ where 
(this_.PTR_JOB_STAT_CD=?) parameters: ['Pending'] 0 ms. at 
org.jboss.resource.adapter.jdbc.WrappedPreparedStatement.executeQuery(WrappedPreparedS
tatement.java:342) 
  

To add this support is very easy. 

Download the jdbcdslog-1.0.5.jar  from http://code.google.com/p/jdbcdslog/ 
Copy a jdbcdslog-1.0.5.jar  to the JBoss server.   

File Copy:  
To    /EclipseWorkbench/jboss-5.1.0.GA/server/default/lib/ jdbcdslog-1.0.5.jar   

 

Next you will have to modify the MySQL configuration: 

Edit the file:  /EclipseWorkbench/jboss-5.1.0.GA/server/default/deploy/mysql-ds.xml 

On the line that has:   

<xa-datasource-class>com.mysql.jdbc.jdbc2.optional.MysqlXADataSource</xa-datasource-
class> 

 

Change the data source class to: 

<xa-datasource-class>org.jdbcdslog.ConnectionPoolXADataSourceProxy</xa-datasource-class> 

 

Next adjust the URL from: 

<xa-datasource-property name="URL">jdbc:mysql://localhost:3306/mts </xa-datasource-
property--> 

 

To: 

    <xa-datasource-property 
name="URL">jdbc:mysql://localhost:3306/mts?targetDS=com.mysql.jdbc.jdbc2.optional.Mysql
XADataSource</xa-datasource-property> 

 

http://code.google.com/p/jdbcdslog/
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Before: 
<xa-datasource> 

 <jndi-name>MySqlDS</jndi-name> 

 <min-pool-size>5</min-pool-size> 

    <max-pool-size>100</max-pool-size> 

 <xa-datasource-class>com.mysql.jdbc.jdbc2.optional.MysqlXADataSource</xa-datasource-
class> 

 <xa-datasource-property name="URL">jdbc:mysql://localhost:3306/mts_training</xa-datasource-
property> 

 <xa-datasource-property name="User">root</xa-datasource-property> 

 <xa-datasource-property name="Password">Bandit10</xa-datasource-property> 

   </xa-datasource> 

After: 
<xa-datasource> 

 <jndi-name>MySqlDS</jndi-name> 

 <min-pool-size>5</min-pool-size> 

    <max-pool-size>100</max-pool-size> 

 <xa-datasource-class>org.jdbcdslog.ConnectionPoolXADataSourceProxy</xa-datasource-class> 

    <xa-datasource-property 
name="URL">jdbc:mysql://localhost:3306/mts_training?targetDS=com.mysql.jdbc.jdbc2.optional.MysqlXA
DataSource</xa-datasource-property> 

 <xa-datasource-property name="User">root</xa-datasource-property> 

 <xa-datasource-property name="Password">Bandit10</xa-datasource-property> 

   </xa-datasource> 

 

Next time you re-start your JBoss server, you will see SQL logged to the console. 

There are some various things you can log they are controlled by the log4j.xml file. 

/EclipseWorkbench/Workspaces/devl/MTCSE_WebApp/src/log4j.xml 

In that file you will notice a half dozen entries that start:  <category name="org.jdbcdslog. 

For each there is a <priority value=" setting. 

OFF means don’t show the data.   

INFO or DEBUG means show the specific info on every SQL call. 

Here are what the specific settings do:   

jdbcdslog provides 3 loggers(in terms of log4j and jakarta commons) to maintain logging level:  
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• org.jdbcdslog.ConnectionLogger - trace connection details.  It produces following log 
entries:  

56 [main] INFO org.jdbcdslog.ConnectionLogger - connect to URL jdbc:hsqldb:. with properties: [user=sa]  

• org.jdbcdslog.StatementLogger - trace statements sent to DB.  It produces following log 
entries:  

62627 [http-8080-1] INFO org.jdbcdslog.StatementLogger - java.sql.PreparedStatement.executeQuery select id, 
email from user where username = ? parameters: ['admin'] 12ms.  

• org.jdbcdslog.SlowQueryLogger - trace slow statements sent to DB.  If query takes more 
time then specified by jdbcdslog.slowQueryThreshold, it will be logged.  

• org.jdbcdslog.ResultSetLogger - trace query results.  It produces following log entries:  

62118 [http-8080-2] INFO org.jdbcdslog.ResultSetLogger - java.sql.ResultSet.next [1234, 'root@a.com']  

 

To turn on other features change the log4j.xml setting from ERROR or FATAL to INFO.  
Rebuild that project, and re-publish and restart the application. 

 

7.12 Testing Reports without the Application 
It may be necessary to be able to look at your report without having to fully install it, and deploy 
the JBoss server. 

You can do this by connecting the report directly to the database. 

First you will have to add the MySQL connection jar to the java build path of MTCSE_Reports. 

In the JavaEE Perspective, right click on MTCSE_Reports -> Properties. 

In the Properties Dialog box, select [Java Build Path] 

Click on [Libraries] tab on the right. 

Click on [Add External Jars…]. 

Here select the jar file located at: 

/EclipseWorkbench/jboss-5.1.0.GA/server/default/lib/ mysql-connector-java-5.1.15-bin.jar 

Click [Open]. 

You should now see Figure 126. 
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Figure 125 

 

Next we will need to create Resource Adapters to connect to the desired Database to use as the 
source of data. 

We need to open the Report Design perspective: 

Click [Window] > [Open Perspective] > [Other…]. 

Find [Report Design] and click [OK].  See Figure 127. 
 

 
Figure 126 
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Now in that perspective, choose the [Repository Explorer] tab. 

Click Data Adapters and right click. 

Choose [Create New Adapter].  See Figure 128. 
 

 
Figure 127 

 

In the Data Adapter Wizard that pops up, select [Database JDBC Connection] 

See Figure 129. 
 

 
Figure 128 

 

Then click [Next]. 

On the next screen, enter a name for your database connection. 

You can create as many of these as you wish.  So if you wanted to see a report for a Test, 
Production or Shadow server and you have firewall access you could set an adaptor up for each 
one. 

Enter the JDBC connection information. 
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The most important things are the server IP, the name of the database, and the username and 
password. 

For development you can enter the information as you see it in Figure 130. 

And be sure to select the MySQL driver [com.mysql.jdbc.Driver]   

Caution There is another MySQL driver.  Make sure that you choose the one that says: 
com.mysql.jdbc.Driver. 

 

When done click [Finish]. 
 

 
Figure 129 
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Now to use your adaptor, open up a JRXML file. 

It will look similar to Figure 131. 
 

 
Figure 130 

 

Click on the [Preview] tab at the bottom. 

On the top you will see a little triangle, just to the left of the larger Green triangle, that allows 
you to select the data adaptor. 

See Figure 132 
 

 
Figure 131 
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Click on that little triangle and choose a data adaptor.  See Figure 133. 

If all goes well, you will see your report populated with data from the database. 
 

 
Figure 132 
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8 Appendix 
This section is a capture of required developer libraries in the event that we want to deploy the 
application on a different server (Tomcat, WebLogic, etc.). 

If we remove JBoss as a dependency for compilation we will need the following jars: 

 

Library Java Class Dependent on it Project Dependency 

Javaee-api-5.0.5.jar javax.ejb.ApplicationException EJBApp 

 SOAPFaultException WebApp 

 ActivationConfigProperty EJBApp 

Hibernate-annotations-
3.40.GA.jar 

Org.hibernate-annotations.IndexColumn EJBApp 

Log4j-1.2.14.jar Category.java EJBApp 

Bsf.jar Org.apache.bsf.util.StringUtils 

Appears that this import is not actually 
being used.  So may not be required if 
we remove the import 

WebApp 

Jboss-system.jar ServiceMIBeanSupport 

Appears to be required to support the 
JBoss cache mechanism 
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